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SPECIFIC LEARNING OUTCOMES 

By the end of this unit you should; 

 Understand databases and know how to manage data using database 

software, e.g. Microsoft Access  

 Be able to use Microsoft Access 

 Construct multi-relation database 

 Be able to query, sort and summarize data 

 Perform database housekeeping activities (editing and updating) 

 Create user interface menus 

Key inquiry questions 

1. What is a database and database management system? 

2. What is Microsoft Access? 

3. What is the importance of databases? 

4. How are data tables created in Microsoft Access? 

5. How are data relations joined in a database? 

6. How is data queried, sorted and summarized to generate reports? 

7. How are books managed in a school library? (a small library information 

system)  



 

 

A database can be defined as a collection of data, or information that is specially 

organized for rapid search and retrieval by a computer. It is a collection of 

information that is organized so that it can be easily accessed, managed and 

updated. Databases are structured to facilitate the storage, retrieval, modification, 

and deletion of data in conjunction with various data-processing operations. 

 

Work in pairs 

A family has four children and a lot of paperwork relating to their education 

(e.g. school books, test papers, school fees, certificates) and their health (e.g. 

medical records, vaccinations). 

They have bought a filing cabinet with four drawers. Suggest how they should 

use the filing cabinet so that they can easily find every document. 

Write your explanations and discuss with your partner. Be prepared to answer 

questions about your explanation. Which pair has the most convincing 

explanation? 

A database is an electronic version of the paper filing system you were been 

planning in activity 1. Obviously an electronic database has many advantages over 

a paper-based system. 

Data is organized into rows, columns and within tables. Databases process 

workloads to create and update themselves, querying the data they contain and 

running applications against it. 

Computer databases typically contain a compilation of data records or files, such as 

sales transactions, product catalogs and inventories, and customer profiles.  

Uses for database systems include: 

 Data storage. They also store special information used to manage the data. 

This information is called metadata and it is not shown to all the people 

looking at the data. 

 Access Control. They can solve cases where many users want to access (and 

possibly change) the same entries of data. They manage access rights (who 

is allowed to see the data, who can change it)  



 

 

 Concurrent users. When there are many users asking questions to the 

database, the questions must be answered faster. So, the last person to ask 

a question can get an answer in reasonable time. 

 Certain attributes are more important than others; they can be used to find 

other data. This is called indexing. An index contains all the important data 

and can be used to find the other data. 

 They ensure that the data always has context. There are a lot of different 

rules that can be added to tell the database system if the data makes sense. 

One of the rules might say November has 30 days. This means if someone 

wants to enter November 31 as a date, this change will be rejected. 

 

Work in pairs 

1. Why is file naming important? 

2. How should you name your file? 

3. How should files be structured? 

Discuss 

Write your explanations and discuss with your partner. Be prepared to explain 

your answer. 

Work together with your partner to develop a presentation that explains in 

detail about file naming and structure and their importance. Relate this to 

everyday usage of data in computers. 

Presentation 

Make your presentation to the class. 

 

 

 

 

 



 

 

 

A database management system (DBMS) is system software for creating and 

managing databases. The DBMS provides users and programmers with a systematic 

way to create, retrieve, update and manage data. 

A database schema is the skeleton structure that represents the logical view of the 

entire database. It defines how the data is organized and how the relations among 

them are associated. It formulates all the constraints that are to be applied on the 

data. 

The DBMS is most useful for allowing access to data by multiple users, from 

multiple locations. A DBMS can limit what data the end user sees, as well as how 

that end user can view the data. 

 Improved data sharing. 

 Integrity can be enforced. 

 Minimized data inconsistency. 

 Providing backup and recovery 

 Improved data security. 

Database management systems are important to businesses and organizations 

because they provide a highly efficient method for handling multiple types of data. 

Some of the data that are easily managed with this type of system include:  

 Employee records 

 Learners information 

 Payroll, accounting 

 Project management 

 Inventory and library books.  

These systems are built to be extremely versatile. 

Without database management, tasks have to be done manually and take more 

time. Data can be categorized and structured to suit the needs of the company or 

organization. Data is entered into the system and accessed on a routine basis by 

assigned users. Each user may have an assigned password to gain access to their 

part of the system. Multiple users can use the system at the same time in different 

ways. 



 

 

For example, a company's human resources department uses the database to 

manage employee records, distribute legal information to employees and create 

updated hiring reports. A manufacturer might use this type of system to keep track 

of production, inventory and distribution. In both scenarios, the database 

management system operates to create a smoother and more organized working 

environment. 

 

Work in groups  

In what ways do you think an electronic database is better than a paper-based system? 

Compare processes involved in each. 

Presentation 

Develop presentations of answers in each question and present to the whole 

class. What are the common answers in each group? 

 

 

1. Relational database management system (RDMS) – This is based on the 

relational model; most databases in widespread use are based on the 

relational database model.  

2. NoSQL DBMS ("not only SQL,”) – this is an approach to database design that 

can accommodate a wide variety of data models, including key-value, 

document, columnar and graph formats.  

3. In-memory database management system (IMDBMS) - this is a database 

management system that primarily relies on main memory for computer 

data storage. It is contrasted with database management systems that 

employ a disk storage mechanism.  

4. Columnar database management system (CDBMS) – this is a database 

management system (DBMS) that stores data tables by column rather than 

by row. In a relational database, data access is always by row. Changing the 

focus from the row to column can improve performance when large 

amounts of data are aggregated in a few columns.  

5. Cloud-based data management system - is a database that typically runs on 

a cloud computing platform, access to it is provided as a service the cloud 

http://searchdatamanagement.techtarget.com/definition/NoSQL-DBMS-Not-only-SQL-database-management-system
http://searchcloudprovider.techtarget.com/definition/cloud-services


 

 

service provider is responsible for providing and maintaining the DBMS. 

Compared with operating a traditional database on an on-site physical 

server and storage architecture, a cloud database offers the following 

distinct advantages:  

 Elimination of physical infrastructure.  

 Cost savings.  

Exercise 1 

1. List the features of each popular type of databases. 

2. What are the uses of popular types of databases? 

Computer programs, particularly those which manipulate data, are built using 

structures and manipulations to organize data with one of the goals being to 

present to a final user data in an organized and comprehensible form.  

Data stored in computer systems form a hierarchy extending from a single bit to a 

database, the major record-keeping entity of a firm. Each higher rung of this 

hierarchy is organized from the components below it. 

Bits and Bytes A bit is the smallest unit of data representation (value of a bit 
may be a 0 or 1). Eight bits make a byte which can represent 
a character or a special symbol in a character code. 

Fields (rows) A field consists of a grouping of characters. A data field 
represents an attribute (a characteristic or quality) of some 
entity (object, person, place, or event). 
 

Records (rows) A record represents a collection of attributes that describe a 
real-world entity. A record consists of fields, with each field 
describing an attribute of the entity. 

Files This is a group of related records. Files are frequently 
classified by the application for which they are primarily used 
(employee file) e.g. employee files, safety records, Test 
scores. 

Databases This is an integrated collection of logically related records or 
files. A database consolidates is managed by systems 
software called database management systems (DBMS).  
 

 

http://searchcloudprovider.techtarget.com/definition/cloud-services


 

 

 

Microsoft Access is a database management system (DBMS) from Microsoft that is 

an information management tool that helps you store information for reference, 

reporting, and analysis.  

Microsoft Access helps you analyze large amounts of information, and manage 

related data more efficiently than Microsoft Excel or other spreadsheet 

applications. 

 

 

 

 

 

 

 

 

 

 

Fig 1.1 MS Access 2016 Welcome Screen 

A spreadsheet program is a terrific tool for maintaining and calculating small sets of 

information.  Microsoft Excel is easy to understand, create column names, enter 

your data, and create formulas.   

You can sort, filter, and format the data quickly and easily.  But spreadsheets are 

not ideal for handling hundreds of records where you need to have "one version of 

the truth" for something like a customer, a contact, or main "thing" you need to 

track.   

It is very easy to introduce errors into a spreadsheet, which then makes analysis, 

summing, and reporting very challenging.  The image below provides a quick 

example of several key challenges spreadsheets face. 



 

 

 

Microsoft Access is equipped with all the tools you will need to start a project, to 

end it, and to distribute it. As is the case for every application, to use Microsoft 

Access, you must launch it, which is done from the menu on the Start button of 

Microsoft Windows. When it starts, Microsoft Access displays two sections: 

 

Figure 1.2 Microsoft access sections 

The left side displays a list of previously used files. The right side displays a list of 

example databases. To start with a project from scratch, you can click Blank 

Desktop Database. This would bring up a dialog box: 

 

 

 

 

 

 

 

In the dialog box, specify the desired name of the file and click Create. 

To Create a Database; 

1. In the middle section, click Blank Desktop Database. 

Figure 1.3 a dialog box 

http://www.functionx.com/access/windows/startup1.png
http://www.functionx.com/access/windows/startup2.png


 

 

2. In the right section of the screen, set the File Name to database. 

3. Click Create. 

Work in pairs 

Open Microsoft Access 

Create a data table with a few columns and insert some simple data. 

Try using each of the tools to manipulate the data to familiarise yourself with the tools. 

Discuss the value of each tool with your class. 

  

The primary language to perform the operations on a database is called the 

structured query language, or SQL. As it is common with other computer 

languages, the SQL has its own syntax, vocabulary, and rules. The SQL language is 

equipped with key words that tell it what to do and how to do it. Microsoft Access 

supports many ways of using, interpreting, or applying the SQL language. 

Code based on SQL is referred to as a SQL statement. In Microsoft Access, to open 

a window you can use to create or use a SQL statement, on the Ribbon, click 

Create. In the Queries section, click Query Design. This would display the Show 

Table dialog box. Click Close. 

To open the window that allows you to write code: 

 Right-click the middle of the Query window and click SQL View 

 On the Ribbon, in the Results section of the Design tab of the Ribbon, click 

the SQL button  

 On the Ribbon, in the Results section, click the arrow of the View button 

and click SQL View 

 On the status bar of the Query window, click the SQL View button  

This would display a window with a default line of code. This is referred to as the 

Query window. In it, you can either edit its existing code or delete the default code 

and replace it with your own code. 



 

 

When writing a SQL statement, the SQL is not case-sensitive. This means that the 

words Case, case, and CASE represent the same thing. This applies to keywords of 

the SQL or words that you will add in your statements. 

After writing your SQL statement, you can execute it to see the result. To do this: 

 In the Results section of the Ribbon, click the Run button  

 In the Results section of the Ribbon, click the View button  

 In the status bar of Microsoft Access, click the Datasheet View button  

After viewing the result, to return to the Query window: 

 Right-click the title bar of the window and click SQL Code 

 In the Results section of the Home tab of the Ribbon, click the arrow of the 
View button and click SQL Code. 

 

As you work through the following section it would be useful to try out the 

processes described so that you gain experience of using the database. 

The most fundamental operator used in the SQL is called SELECT. This operator is 
primarily used to display a value to the user. In this simple case, it uses the 
following formula: 

SELECT Value; 

The value on the right side of SELECT must be appropriate. It can be a number. 

Here is an example: 

SELECT 48; 

When you write a SQL statement, the semicolon is optional. This means that you 

can omit it. 

SELECT This AS 

Practical Example 



 

 

When you execute a SQL statement in the Query window, its results are displayed 
in a spread sheet. To be able to recognize a value, the top section of a column of 
the spread sheet displays a label, called a caption. For example, the above would 
produce: 

 

Figure 1.4 value selection 

If you create a simple SELECT Value; Microsoft Access assigns a default caption to 

the column. The SQL allows you to specify a caption that would be used for the 

value. This is done using the following basic formula: 

SELECT Value as Caption; 

The words, “SELECT” and “AS” are required. As mentioned already, “SELECT” would 

be used to specify a value and “AS” in this case allows you to specify a caption of 

your choice. 

The caption can be made of a word but the word cannot be one of the SQL's 

keywords. Here is an example: 

SELECT 48 AS Age; 

This would produce: 

 

Figure 1.5 24.85 selection 



 

 

You can also use non-literal characters or digits in the caption. If the caption is 

made of a combination of words, you can concatenate them to create one word. 

Here is an example: 

SELECT 24.85 AS Hourly Salary; 

This would produce: 

 

Figure 1.6 48 selection 

If you want the caption to display different words, you can include them between 

an opening square bracket "[" and a closing bracket "]". Here is an example: 

SELECT 25.05 AS [Hourly Salary]; 

This would produce: 

 

Figure 1.7 25.05 selection 

Instead of displaying one column, you may want to display more. To do this, 

separate them with commas. Here is an example: 

SELECT 42.50 AS [Weekly Hours], 25.05 AS [Hourly Salary]; 

This would produce: 



 

 

 

Figure 1.8 42.05 selection 

Besides a number, the value of a SELECT expression can be a string. If it is, you can 

include it between single-quotes. Here is an example: 

SELECT 'Martens, Laurent' AS [Employee Name]; 

In the same way, you can mix number-based and string-based columns. 

The structured query language comes in two broad parts. The data definition 

language (DDL) is the SQL part used to create the objects of a database. 

A form is a rectangular object that hosts other objects and allows a database user, 

also called a user, to interact with the application. There are various ways you can 

create a form. If you want to immediately use the form, on the Ribbon, click Create. 

In the Forms section, click Form View. 

If you want to prepare the form to receive other objects, this is referred to as 

design. To open a form for design, on the Ribbon, click Create. In the Forms section, 

click Form Design. When a form is in design, you can add objects to it. 

 

 

 

As you work through the following section it would be useful to try out the 

processes described so that you gain experience of using the database. 

Practical Example 



 

 

The Form View is the view used for regular operations on a form. To open a form in 

Form View: 

In the navigation panel:  

 Double-click the name of the form 

 Right-click the form and click Open 

If the form is opened in another type of view:  

 In the navigation Pane, double-click the name of the form. 

 On the Ribbon, click Home, Design, or Datasheet (this depends on the type 

of view). In the Views section (on the left of the Ribbon), click the arrow 

button under View, and click Form View. 

 On the status bar, click the Form View button. 

 

 

Figure 1.9 form view button 

The design of a form is done by displaying the object in Design View. To present a 

form in Design View: 

If the form is currently closed, in the Navigation Pane, right-click the form and click 

Design View 

If the form is currently opened: 

 In the Navigation Pane, right-click the form and click Design View 

 Right-click its title bar or tab and click Design View 

 Right-click it (somewhere on its body) and click Design View 

 On the Ribbon, click Home. In the Views section, click the arrow button 

under View and click Design View  



 

 

 

Figure 1.10 design view 

 On the right side of the status bar, click the Design View button  

 

Figure 1.11 design view button 

If the form is currently displaying in Design View and you want to switch it to Form 

View: 

In the Navigation Pane:  

 Double-click the name of the same form 

 Right-click the name of the same form and click Open 

On the Ribbon, click either Design or Home, in the Views section:  

 Click the View button 

 Click the down-pointing button under View and click Form View 

To start a simple report, on the Ribbon, click Create. In the Reports section, click 

Report View. To start a report that will host some objects, which referred to as 

design, on the Ribbon, click Create. In the Reports section, click Report Design. If 

the report is currently closed or it displays in another view, you can switch the view 

using the same techniques applied to a form. 



 

 

The Detail section is the primary host of the controls on a form or report. The 

section is primarily characterized by its height. To visually change the height of the 

Detail section, click and drag the lower border of the Detail section: 

 

Figure 1.12 lower border drags 

A form can be equipped with a Form Header and a Form Footer sections. To add 

these sections, right-click the middle of the form and click Form Header/Footer:  



 

 

 

Figure 1.13 form header/ footer selection 

  

Figure 1.14 report header/ footer selection 

A report can be equipped with a Report Header and a Report Footer section. To 

add these sections, right-click the body of the report and click Report 

Header/Footer: 



 

 

 

 

Figure 1.15 report header and footer selection. 

You can increase the height of a section or reduce the height, sometimes 

completely. This allows you to keep one section and hide the other. 



 

 

The width of a form or that of a report is the distance from its left border to its 

right border. All sections use the same width. To widen or narrow a form or report, 

click and drag the right border: 

 

Figure 1.16 widening and narrowing selection 

The height of a form or report is controlled by its sections. 

To change both the width and the height of a form or report at the same time, 

position the mouse on the lower-right corner: 



 

 

 

Figure 1.17 drag left, right, up, down, or diagonally 

Then click and drag left, right, up, down, or diagonally. 

If you want to resize a form enough to show its whole content, on the Ribbon, click 

Home. In the Window section, click Size to Fit Form. 

There are various ways you can create a database. To visually start a database from 

scratch, after launching Microsoft Access, click Blank Desktop Database. In the right 

section, accept or change the name of the database. 

If you want to create a contemporary database, either omit or add the .accdb 

extension. If you want to create a database that is compatible with earlier versions 

of Microsoft Access, you must add the extension .mdb. 

After specifying the name, to specify a folder of your choice, under File Name and 

on the right side of the name of the database, click the Browse button . This 

would open the File New Database dialog box. You can click the arrow of the Save 

In combo box to select a drive such as (A:), (C:), etc. 



 

 

After selecting the drive, you can either select an existing folder or create a new 

folder by clicking the Create New Folder button on the right side of the Save In 

combo box. You can also use a directory on the network as the repository of the 

new database. 

Access comes with a variety of templates that you can use as-is or as a starting 

point. A template is a ready-to-use database that contains all the tables, queries, 

forms, macros, and reports needed to perform a specific task. For example, there 

are templates that you can use to track issues, manage contacts, or keep a record 

of expenses. Some templates contain a few sample records to help demonstrate 

their use. 

If one of these templates fits your needs, using it is usually the fastest way to get a 

database started. However, if you have data in another program that you want to 

import into Access, you might decide it is better to create a database without using 

a template. Templates have a data structure already defined, and it might require a 

lot of work to adapt your existing data to the template's structure. 

1. If you have a database open, on the File tab, click Close. Backstage view 

displays the new tab. 

2. Several sets of templates are available in the new tab, some of which are 

built into Access. You can download additional templates from Office.com. 

See the next section in this article for details. 

3. Select the template that you want to use. 

4. Access suggests a file name for your database in the File Name box — you 

can change the file name, if you want. To save the database in a different 

folder from the one displayed below the file name box, click , browse to 

the folder in which you want to save it, and then click OK. Optionally, you 

can create and link your database to a SharePoint site. 

 

Note: Although they both use SharePoint, a desktop database linked to a 

SharePoint site is not the same as a web database using Access Services. To 

use a desktop database, you must have Access installed. A web database 

can be used with a web browser. 

5. Click Create. 

Access creates a database from the template that you chose, and then 

opens the database. For many templates, a form is displayed in which you 

can begin entering data. If your template contains sample data, you can 



 

 

delete each record by clicking the record selector (the shaded box or bar 

just to the left of the record), and then doing the following:  

On the Home tab, in the Records group, click Delete.  

6. To begin entering data, click in the first empty cell on the form and begin 

typing. Use the Navigation Pane to browse for other forms or reports that 

you might want to use. Some templates include a navigation form which 

allows you to move between the different database objects. 

 

As you work through the following section it would be useful to try out the 

processes described so that you gain experience of using the database. 

1. On the File tab, click New, and then click Blank Database. 

2. Type a file name in the File Name box. To change the location of the file 

from the default, click Browse for a location to put your database 

(next to the File Name box), browse to the new location, and then click 

OK. 

3. Click Create.  

Access creates the database with an empty table named Table1, and 

then opens Table1 in Datasheet view. The cursor is placed in the first 

empty cell in the Click to Add column. 

4. Begin typing to add data, or you can paste data from another source, as 

described in the section Copy data from another source into an Access 

table. 

Entering data in Datasheet view is designed to be very similar to working in an 

Excel worksheet. The table structure is created while you enter data. When you 

add a new column to the datasheet, a new field is defined in the table. Access 

automatically sets each field's data type, based on the data that you enter. 

If you do not want to enter data in Table1 at this time, click Close . If you made 

any changes to the table, Access prompts you to save the changes. Click yes to save 

your changes, click No to discard them, or click Cancel to leave the table open. 

Practical Example 

https://support.office.com/en-us/article/Create-a-new-database-32a1ea1c-a155-43d6-aa00-f08cd1a8f01e#__toc269904808
https://support.office.com/en-us/article/Create-a-new-database-32a1ea1c-a155-43d6-aa00-f08cd1a8f01e#__toc269904808


 

 

You can add new tables to an existing database by using the commands in the 

Tables group on the Create tab.  

 

Create a table, starting in Datasheet view    In Datasheet view, you can enter data 

immediately and let Access build the table structure behind the scenes. Field 

names are assigned numerically (Field1, Field2, and so on), and Access 

automatically sets each field's data type, based on the data you enter. 

1. On the Create tab, in the Tables group, click Table.  

Access creates the table and selects the first empty cell in the Click to Add 

column. 

2. On the Fields tab, in the Add & Delete group, click the type of field that you 

want to add. If you do not see the type that you want, click More Fields . 

3. Access displays a list of commonly used field types. Click the field type that you 

want, and Access adds the new field to the datasheet at the insertion point. 

You can move the field by dragging it. When you drag a field in a datasheet, a 

vertical insertion bar appears where the field will be placed. 

4. To add data, begin typing in the first empty cell, or paste data from another 

source, as described in the section Copy data from another source into an 

Access table.  

5. To rename a column (field), double-click the column heading, and then type the 

new name.  

You should give a meaningful name to each field, so that you can tell what it 

contains when you see it in the Field List pane. 

6. To move a column, click its heading to select the column, and then drag the 

column to the location that you want. You can also select multiple contiguous 

columns and then drag them to a new location all at once. To select multiple 

contiguous columns, click the column header of the first column, and then, 

while holding down SHIFT, click the column header of the last column.  

 

 

https://support.office.com/en-us/article/Create-a-new-database-32a1ea1c-a155-43d6-aa00-f08cd1a8f01e#__toc269904808
https://support.office.com/en-us/article/Create-a-new-database-32a1ea1c-a155-43d6-aa00-f08cd1a8f01e#__toc269904808


 

 

 

As you work through the following section it would be useful to try out the 

processes described so that you gain experience of using the database. 

1. Click the Create tab, and then click the Table Design button, or 
select the table you want to modify in the Navigation pane, and then 
click the Design View button.  

 

 

 

 

 

 

 

 

 

 

2. Click in a Field Name cell, and then type a modified field name. 
3. Click in a Data Type cell, click the Data Type list arrow, and then click 

a data type. 
4. Click in a Description cell, and then type a description. If the 

Property Update Options button appears, select an option, if 
necessary. 

5. To insert a field, click the row selector below where you want the 
field, and then click the Insert Rows button on the Ribbon. 

Practical Example 

Figure 1.18 create selection 

javascript:popUp('/content/images/chap3_9780789750471/elementLinks/03fig18_alt.jpg')


 

 

6. To delete a field, click the row selector for the field you want to 
delete, and then click the Delete Rows button on the Ribbon. 

7. Click the Save button on the Quick Access Toolbar, and then if 
necessary, enter a table name and click OK. 

Follow the steps below:  

Go ahead and create two tables as follows. 

 

 

Be sure to set a format and default value for the DateCreated fields on both 

tables (the user should not need to enter this field - the system can do that). 

 

Key icon indicates that the field is a primary key. A primary key ensures that the 
data in this field is unique - no two values can be the same. A table must have a 
primary key before a relationship can be established with another table. Access 



 

 

automatically sets the ID field as a primary key, so as long as you simply rename 
ID to ProductId (or OrderId as the case may be) it will already be a primary key. 
If for some reason your table does not have a primary key set, or if you want to 
change the primary key field, you can simply right click on the field header (in 
Design view), and select Primary Key from the contextual menu. 

Now that you have created two extra tables, our database has three tables. Now it 

is time to create the relationship between all three tables. 

1. While viewing a table in Design view, and ensuring that the DESIGN tab is 
selected, click Relationships from the Ribbon:  

 

 

Figure 1.19 relationship selection 

2. A Show Table dialog box will pop up, displaying all three tables. Select all of 
them and click Add:  

 

Figure 2.0 tables selection 



 

 

3. Click Close to close the dialog box 
4. You will now see three boxes which represent your three tables. Click and drag 

the CustomerId from the Customers table across to the corresponding 

CustomerId field on the Orders table:  

 

 

 

Figure 2.1 CustomerId selection 

It would be good to add some data and check that the database works as intended 

and to correct it if necessary. 

5. The Edit Relationships dialog will pop up. Click Enforce Referential 
Integrity so that it is checked. Check that the values are the same as the 
following screenshot and click OK: 

 

Figure 2.2 edit relationships selection 



 

 

You will now see a line established between the CustomerId field on the 
Customers table and the CustomerId on the Orders table.  

6. Now do the same for the Products table. That is, click and drag the 
ProductId from the Products table across to the corresponding 

ProductId field on the Orders table. Your table relationships should look 
like the ones in the following screenshot: 

 

Figure 2.2 products table selection 

 

Imagine you are running a company selling 50 different types of widgets all over 

the world. You have a client base of 1,250 and in an average month sell 10,000 

widgets to these clients. You are currently using a single spread sheet to track all of 

these sales – effectively a single database table. And every year adds thousands of 

rows to your spread sheet. 

 

Figure 2.4 images of the order tracking spreadsheet you are using  



 

 

The above images are part of the order tracking spreadsheet you are using. Now 

say both of these clients buy widgets from you several times a year so you have far 

more rows for both of them. 

If Joan Smith marries Ted Baines and takes his surname, every single row that 

contains her name now needs to be changed. The problem is compounded if you 

happen to have two different clients with the name ‘Joan Smith’. It has just become 

much harder to keep your sales data consistent due to a fairly common event. 

By using a database and normalizing the data, we can separate out items into 

multiple tables such as inventory, clients, and orders. 

 

Figure 2.5 orders and client table 

Just looking at the client portion of our example, we would remove the columns for 

Client Name and Client Address and put them into a new table. In the image above, 

things have broken up for a better granular access to the data. The new table also 

contains a column for a Primary Key (Client ID) – a number that will be used to 

access each row in this table. 

In the original table where we removed this data, we would add a column for a 

Foreign Key (Client ID) which is what links to the proper row containing the 

information for this particular client. 

Now, when Joan Smith changes her name to Joan Baines, the change only needs to 

be made once in the Client table. Every other reference from joined tables will pull 

the proper client name and a report that is looking at what Joan has purchased for 

the last 5 years will get all of the orders under both her maiden and married names 

without having to change how the report is generated. 

As an added benefit, this also reduces the overall amount of storage consumed. 



 

 

A join clause combines columns from one or more tables in a relational database. 

SQL defines five different types of joins: INNER, LEFT OUTER, RIGHT OUTER, FULL 

OUTER, and CROSS. The OUTER keyword is optional in the SQL statement. 

Microsoft Access allows the use of INNER (default), LEFT OUTER, RIGHT OUTER, and 

CROSS. FULL OUTER is not supported as such, but by using LEFT OUTER, UNION ALL, 

and RIGHT OUTER, it can be faked at the cost of more CPU cycles and I/O 

operations. 

The output of a CROSS join contains every row of the left table paired with every 

row of the right table. The only time one can see a CROSS join used is during load 

testing of database servers. 

Let us start by creating two tables, ProdA and ProdB, with the following design 

properties. 

 

The AutoNumber is an automatically incrementing long integer assigned to entries 

as they are added to the table. The Text option was not modified, so it will accept a 

text string up to 255 characters long. 

Now, populate them with some data. 

 

To show the differences in how the 3 join types work, delete entries 1, 5, and 8 from 

ProdA. 



 

 

 

Next, create a new query by going to Create > Query Design. Select both tables 

from the Show Table dialog and click add, and then Close. 

 

Click on ProductID in table ProdA, drag it to ProductID in table ProdB and release 

the mouse button to create the relationship between the tables. 

 

Right-click on the line between the tables representing the relationship between 

the items and select Join Properties. 



 

 

 

By default, join type 1 (INNER) is selected. Option 2 is a LEFT OUTER join and 3 is a 

RIGHT OUTER join. 

We will look at the INNER join first, so click OK to dismiss the dialog. 

In the query designer, select the fields we want to see from the drop-down lists. 

 

When we run the query (the red exclamation point in the ribbon), it will show the 

Product Name field from both tables with the value from table ProdA in the first 

column and ProdB in the second.  

 

Notice the results only show values where ProductID is equal in both tables. Even 

though there is an entry for ProductID = 1 in table ProdB, it does not show up in the 

results since ProductID = 1 does not exist in table ProdA. The same applies to 

ProductID = 11. It exists in table ProdA but not in table ProdB. 



 

 

 

Figure 2.6 select selection 

By using the View button on the ribbon and switching to SQL View, you can see the 

SQL query generated by the designer used to get these results. 

SELECT ProdA.ProductName, ProdB.ProductName FROM ProdA INNER JOIN 

ProdB ON ProdA.ProductID = ProdB.ProductID; 

Going back to Design View, change the join type to 2 (LEFT OUTER). Run the query 

to see the results.  

 

Figure 2.6 products A and B represented 

As you can see, every entry in table ProdA is represented in the results while only 

the ones in ProdB that have a matching ProductID entry in table ProdB show up in 

the results. 

The blank space in the ProdB.ProductName column is a special value (NULL) since 

there is not a matching value in table ProdB. This will prove important later. 

SELECT ProdA.ProductName, ProdB.ProductName FROM ProdA LEFT JOIN 

ProdB ON ProdA.ProductID = ProdB.ProductID; 

 



 

 

 

Figure 2.7 product table  

Try the same thing with the third type of join (RIGHT OUTER). 

The results show everything from table ProdB while it is showing blank (known as 

NULL) values where the ProdA table does not have a matching value. So far, this 

brings us closest to the results desired in our reader’s question. 

SELECT ProdA.ProductName, ProdB.ProductName FROM ProdA RIGHT JOIN 

ProdB ON ProdA.ProductID = ProdB.ProductID; 

 

The results of a function may also be returned as part of a query. We want a new 

column named ‘Results’ to appear in our result set. Its value will be the content of 

the ProductName column of table ProdA if ProdA has a value (it is not NULL), 

otherwise it should be taken from table ProdB. 

The Immediate IF (IIF) function can be used to generate this result. The function 

takes three parameters. The first is a condition that must evaluate to a True or 

False value. The second parameter is the value to be returned if the condition is 

true, and the third parameter is the value to be returned if the condition is False. 

The full function construct for our situation looks like this: 

IF (ProdA.ProductID Is Null, ProdB.ProductName, ProdA.ProductName) 

 

Notice that the condition parameter does not check for equality. A Null value in a 

database does not have a value that can be compared to any other value, including 



 

 

another Null. In other words, Null does not equal Null. Ever. To get past this, we 

instead check the value using the ‘Is’ keyword. 

We could have also used ‘Is Not Null’ and changed the order of the True and False 

parameters to get the same result. 

When putting this into the Query Designer, you must type the entire function into 

the Field: entry. To get it to create the column ‘Results’, you need to use an alias. 

To do this, preface the function with ‘Results:’ as seen in the following screenshot. 

 

Figure 2.8 product name selection 

The equivalent SQL code to do this would be: 

SELECT ProdA.ProductName, ProdB.ProductName, IF (ProdA.ProductID Is 

Null,ProdB.ProductName,ProdA.ProductName) AS Results FROM ProdA 

RIGHT JOIN ProdB ON ProdA.ProductID = ProdB.ProductID; 

 

Now, when we run this query, it will produce these results. 

 

Figure 2.9 query results 

Here we see for each entry where table ProdA has a value, that value is reflected in 

the Results column. If there isn’t an entry in the ProdA table, the entry from ProdB 

appears in Results  

 

 



 

 

Follow the steps as unit overview on creating a database.   

1. Click the Tables tab in the database window.   
2. Click New. 
3. The New Table Wizard appears.  
4. Select Table Wizard and click OK. 
5. Select the Personal toggle located above the Sample Tables column.  Select 

Addresses from the Sample Tables column (left click once to highlight.) 
6. Select First Name from the Sample Fields column (click once to highlight the 

selection.) Click the right pointing arrow button or double click the selection to 
add it to the Fields in My New Table column. 

7. Repeat step #6 with Last Name, Address, City, State, Postal Code, and Home 
Phone Number from the Sample Fields column. 

8. Click Next. 
9. The Table Wizard offers the name “Addresses” for your table; we’ll keep that 

name.  (On this same screen, there is a "YES" default for setting a Primary Key). 
Click Next.  

10. Click Finish and view your new table. 
11. Close the “Addresses” table (Click the X in the top right corner of the table 

window.) 
 

1. Click the Tables tab in the database window. 
2. Double click Addresses to open the table we have created. In the table fields, 

ignore the one labeled Addresses ID for now. 
3. Press the right arrow key or tab key and enter these field values, pressing enter 

after each value: 
 

First 

Name 

Last Name Address City  State ZIP  Phone # 

Betty  Bop Akobo Jonglei SS  72213 (+211) 005555 

Daffy  Duck Buragwa Jonglei SS 72213 (+211)119999 

Mickey  Mouse Korial Jonglei SS 72213 (+211)225555 

 

4.   Click Save and close the table. 



 

 

1. Click the Forms tab in the database window. 
2. Click New. 
3. The New Form Window appears. 
4. Select Form Wizard and click OK. 
5. Click the two right pointing arrows button to move all the fields over to the 

right side of the window. 
6. Select Address ID and click the left pointing arrow button to move it back over 

to the Available Field side of the window. 
7. Click Next. 
8. Select Columnar; Click Next.  Select Standard style; Click Next. 
9. The wizard offers “Addresses” for the form title, which is fine.  
10. Click Finish and view the form. 
11. Click the right pointing arrow button at the bottom of the form window (next to 

the Record: box).   Click this arrow two more times and notice the entries.  The 
form should be empty on the fourth record.   

12. Click Save and close the form. 
 

In Access, you can enter data into Tables or Forms.  Let us use the form we just 

created to enter more data. 

1. Click the Forms tab in the database window 
2. Double click “Addresses” to open the form. 
3. Click the right pointing arrow with a star button at the bottom of the form.  The 

form should be on the fourth record, which is blank.  Enter the following field 
values.  Press the enter key or tab key after each entry to move to the next cell. 

 

First 

Name 

Last 

Name 

Address City  State ZIP Code Phone # 

Sponge  Bob Abwong Upper Nile SS 71100 (+211)440022 

 

4. Betty Bop is spelled incorrectly.  Click the left arrow with a line button at the 
bottom of the form.  This will automatically take you to the first record. 

5. Click the Last Name text box with the word “Bop.”  Click before the “p” and 
enter “o.”  It should now read “Boop.” 

6. Click Save and close the form. 



 

 

7. Access should automatically update the table with the new form data.  Click the 
Tables tab and double click Addresses to open the table 

8. You should see the Sponge Bob record and the spelling correction of “Boop” in 
the table. 

9. Click Save.  
10. Close the table (click the X in the top right hand corner of the window.) 
 

Let us find the people in our Address Book database that live in Houston.  We are 

planning a last minute birthday party and need to call them immediately.  We have 

four records in our database.  If there were more records, it would be time 

consuming to go through all the addresses.  Queries allow you to pluck only certain 

pieces of data out of your database.  Let us make a query to find the people in our 

database that are located in Houston.  

1. Click the Queries tab in the database window. 
2. Click New. 
3. The New Query Window appears.  Select Simple Query Wizard and click OK 
4. Click the downward pointing arrow on the right of the Tables/Queries: text box. 
5. Select Table: Addresses. 
6. Select First Name, Last Name, City, and Home Phone  field values (click once to 

highlight the selection and then click the right pointing arrow or double click 
the selection) and move to the Selected Fields side of the window.  

7. Click Next. 
8. Under “What title do you want for your query?” type: Houston in the text box 

and click Finish. 
9. The results are displayed.  The records are displayed with four fields that were 

included in the search. We only want the records that include the city Houston.  
We have a little more work to do. 

10. Select query Houston already created. Click on Design icon on the toolbar to 
look at the query in Design View. 

11. At the bottom half of the screen there is a grid.  Under the City column and 
along the Criteria row, we want to type: Houston in that cell.  We are making a 
query, which looks for only those records that include Houston – not the friends 
that live in Humble, for example. 

12. Click the Run tool (red exclamation point) on the tool bar to get the results of 
the query. 

13. The records that include Houston are displayed.  Now we know who to call and 
their phone number. 

14. Click Save and close the database window. 
15. Close Access. 



 

 

Create a database file, which will require you to create one table, one query, one 

form, and one report.     

Create table: CUSTOMERS 

Create  the  field  names  and  their  properties  as  you  need  them  to  store  your  

specific  data  for  customers.  You  will  have at  least five  customers  with  their  

information  included  in  your  customer table.   

CUSTOMERS Table Field Names: 

Customer ID (Primary Key: CID) 

First Name (FNAME) 

Last Name (LNAME) 

City (CITY) 

State (STATE) 

Number of Purchases (PNUMBER) 

Total Amount of Purchases (PTOTAL) 

Date of Last of Purchase (PLAST) 

Create query: NY Customers 

Create a query that displays only the MSA customers sorted by last name in 

ascending order. 

Create report: NY Customers Report  

Create a report from the NY Customers query.   

Create form: New Customers 

Create a form for the Customers table. Include all fields in the form. Use the Form 

Wizard to create a form. Using the New Customers form, enter two additional 

customers:  

Mathieu Alfa Birir    NRB 3 $150.00 March 12, 2010 

Jennifer Cherbich   MSA 2 $250.00 March 17, 2010 

 


























































































































































































































































































